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FEATURE  OF  THE  MONTH - DEC.  2007 

 
GAMBART 

Sketch and text by Robert H. Hays, Jr. - Worth, Illinois, USA 
July 7, 2007 - 07:35 to 08:01 UT 

15cm Newtonian - 170x - Seeing: 7-8/10 
 

I sketched this crater and vicinity on the morning of July 7, 2007 before the emersion of an 8th-
magnitude star. This is a middling crater southeast of Copernicus. It has noticeable points on its east and 
west rims, and a tiny gap to the northwest. Its floor appeared smooth and featureless, and the same tint 
as the surrounding mare. Gambart NA is just southwest of Gambart, while Gambart N is farther to the 
south. The tiny pit Gambart EA is to the northwest, and is surrounded by a small halo. Two wide, low 
ridges extend southwestward from Gambart; one of them contains NA. More low elevations lie to the 
west and north. A pair of rounded hills are to the southeast, and east of Gambart N. The more southerly 
one looks almost double, and has a tiny peak on top. It gives the appearance of a pebble on a boulder. A 
small, bright, shadowless patch is just east of this hill. A faint ray runs northwest-southeast east of 
Gambart; this ray may be from Copernicus. 

RECENT  BACK  ISSUES:   http://www.zone-vx.com/tlo_back.html

http://www.zone-vx.com
http://www.zone-vx.com/tlo_back.html
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AN  INVITATION  TO  JOIN  THE  A.L.P.O.
 

The Lunar Observer is a publication of the Association of Lunar 
and Planetary Observers that is available for access and 
participation by non-members free of charge, but there is more to 
the A.L.P.O. than a monthly lunar newsletter.  If you are a non-
member you are invited to join our organization for its many other
advantages. 
 
We have sections devoted to the observation of all types of bodies 
found in our solar system. Section coordinators collect and study 
members’ observations, correspond with observers, encourage 
beginners, and contribute reports to our Journal at appropriate 
intervals. 
 
Our quarterly journal, The Strolling Astronomer, contains the 
results of the many observing programs which we sponsor 
including the drawings and images produced by individual 
amateurs. Additional information about the A.L.P.O. and its 
Journal can be found on-line at: http://www.alpo-
astronomy.org/index.htm I invite you to spend a few minutes 
browsing the Section Pages to learn more about the fine work being 
done by your fellow amateur astronomers.  
 
To learn more about membership in the A.L.P.O. go to:
http://www.alpo-astronomy.org/main/member.html  which now 
also provides links so that you can enroll and pay your membership 
dues online. 

http://www.alpoastronomy.org/index.htm
http://www.alpo-astronomy.org/main/member.html
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LUNAR  CALENDAR  -  DECEMBER  2007  (UT)

Dec. 01 11:00 Moon 2.1 Degrees SSW of Saturn 
Dec. 01 12:44 Last Quarter 
Dec. 05 18:00 Moon 6.5 Degrees SSW of Venus 
Dec. 06 16:55 Moon at Apogee (406234 km - 252422 miles) 
Dec. 09 08:00 Moon 4.4 Degrees S of Mercury 
Dec. 09 17:40 New Moon (Start of Lunation 1051) 
Dec. 10 16:00 Moon 4.6 Degrees S of Jupiter 
Dec. 12 22:00 Moon 0.43 Degrees SE of asteroid Vesta 
Dec. 14 19:00 Moon 0.65 Degrees SE of Neptune 
Dec. 16 00:00 Moon 0.95 Degrees NNW of asteroid Pallas 
Dec. 16 16:00 Moon 2.1 Degrees NNW of Uranus 
Dec. 17 10:17 First Quarter 
Dec. 22 10:12 Moon at Perigee (360816 km - 224201 miles) 
Dec. 24 01:15 Full Moon 
Dec. 24 03:00 Moon 0.92 Degrees N of Mars 
Dec. 28 20:00 Moon 2.5 Degrees SSW of Saturn 
Dec. 31 07:50 Last Quarter 

 

CALL  FOR  OBSERVATIONS: 
FOCUS  ON: Alphonsus 

 
Focus on is a bi-monthly series of articles which includes observations received for a specific feature 
or class of features. The subject for the January 2008 edition will be the crater Alphonsus. 
Observations of all kinds (electronic or film based images, drawings, etc.) are welcomed and invited. 
Keep in mind that observations do not have to be recent ones, so search your files and/or add this 
fascinating crater to your observing list and send your favorites to Dembowski@zone-vx.com 
 

Deadline for inclusion in the Alphonsus article is December 20, 2007 
 

Be sure to check the November issue of TLO (Pages 3 & 4) 
for information on Alphonsus LTP observations: 

http://www.zone-vx.com/TLO200711.pdf 

http://www.zone-vx.com/TLO200711.pdf
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THREE  APOLLO  LANDING  SITES 
Rik Hill - Tucson, Arizona, USA 

 

 
APOLLO-11  LANDING  SITE  NEAR  RITTER  &  SABINE 

May 23, 2007 - 04:08 UT - 14 inch SCT - Philips  Toucam 
 

 
 
 

 
APOLLO-17  LANDING  SITE  NEAR  LITTROW 

September 30, 2007 - 07:32 UT - 14 inch SCT - Philips Toucam 
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Locations of Apollo Landing Sites - (Courtesy of NASA) 
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BANDS  WITHIN  ARISTARCHUS 
Fred Corno - Settimo Torinese, Italy 

 
With reference to the observation published on Page 17 of the October issue of TLO 

(http://www.zone-vx.com/TLO200710.pdf) 
 

 
Mr. Eskildsen reports the presence of three bands in Aristarchus. I browsed through the observations I 
have of the same crater. I have three of them, but just two with some detail. I observed the same 
bandings as Mr. Eskildsen. The “c” band was somehow faint and difficult to make out in the second 
(2003) observation but I suspect it being there. The only very big difference I noticed is that in my 
observations “a” rises up to the rim of the crater. 
 
 

 
 
 
 
 

23 August, 2002 
22:00 to 23:15 UT 

Vixen VMC200L - 231x 
Seeing: AIII 

 
 
 
 
 
 

 
 

 
 
 
 
 

15 March, 2003 
23:35 to 00:25 UT 

Vixen VMC200L - 216x 
Seeing: AII to AIII 

 
 
 
 
 
 
 

http://www.zone-vx.com/TLO200710.pdf
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AN  INTRODUCTION  TO  LTVT 
Alexandros Filothodoros - Samos, Greece 

 
 
LTVT is a very useful and powerful freeware program written by Jim Mosher. It provides functions and 
accuracy that other programs do not offer and the interface is very easy to use. 
   
By just moving the cursor over the Moon, the Cartesian coordinates of the feature are displayed. There 
is no need to convert them to Selenographic coordinates since this is done automatically. Other 
indications will be displayed as well, depending on the user's selection in the  
“Tools-> mouse options” menu. 
   
For images showing only a part of the Moon, as well as close ups, the “High Resolution Shaded Relief” 
or the “Clementine Photo Mosaic” will be needed. In order to do this you need to associate the file with 
the specific texture you wish. LTVT contains only a file (lores.jpg) for the “Lower Resolution Shaded 
Relief” so you will need to add one for higher resolution. It's easy if you have already installed VMA as 
these two software programs complement each other. You just have to choose the “Change File 
Associations” option and follow the instructions in order to use the “hires.jpg” file from VMA, or the 
“hires_clem.jpg” if you wish to use the “Clementine Photo Mosaic texture”. Furthermore, there is an 
option for user made images. The greyscale of the image is calculated by the texture map and not by 
LTVT.  
    
Users must enter their location coordinates which are needed for the correct projection of the Moon. All 
other necessary geographical information (including the sub-observer and sub-solar points which are 
needed for a very exact estimation of the location where the terminator will be cast) are calculated 
automatically. To ensure accuracy, manually entered coordinates must belong to the same coordinate 
system as used by the texture map. 
    
If the “Overlay dots” button is clicked, dots will appear that show the positions, name and diameter (if 
crater) of some lunar features. Notice that the dots have four different colours, depending on the 
diameter of the crater. If the dot doesn't represent a crater then it is yellow. All information is displayed 
on the lower right of the main window. If the “Label” button is clicked, the names of the features 
represented by a dot will be displayed on the lunar disk. In the “Named_Lunar_Features.csv” the user 
can add their own places to be dotted. The colours of the dots can be changed in the “Tools→Change 
dot/label preferences” menu. 
 
Using LTVT the user can do serious studies on their own lunar photos, such as distance, height or 
elevation calculations. First the user's image must be calibrated so that the correct geometry for the place 
and time the image was taken will be computed. (Use the “File→Calibrate a photo” menu). 
LTVT can predict same lighting conditions for a specific feature. That's very useful in LTP research and 
in imaging the light rays passing through crater walls. (Use the “Predict” button on the main window). 
Go to “Tools→Change mouse options” to choose the kind of measurement you wish to make. In all 
cases a reference point must be set. (Right click →set as reference point). Sometimes, especially when 
studying crater rays, it is better to make measurements using the negative of the image. 
  
Notice that the first time a calibrated image is saved, a “PhotoCalibrationData.txt” file is created in the 
file where LTVT is set up. In this file, information such as time, geographical, and some graphic 
information along with the directory path of the images are saved for every calibrated image. The user 
can save in this file somebody else’s image just by copying all of the above information into the 
“PhotoCalibrationData.txt” file. Don't forget to change the directory path with the one on your 
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computer. After that the image is in the list of the calibrated images even if someone else has calibrated 
it. (File→Load a calibrated Photo). The “LTVT.ini” file can be used as an alternative way to change and 
save options such as the location and the external files used for textures 
The Lunar Topographic Orthophotomaps (T.L.O.) maps can also be used for examination of regions 
near the equator. The map must be calibrated so that the coordinate values will be correct. To make use 
of the Topophotomaps, the values must be converted by the user from degrees and minutes to decimal 
degrees. After the calibration is finished, the map can be used as a texture. Also, the user can add labels 
to their images indicating the measurements that have been made (i.e. Distance measurements from a 
reference point). By right-clicking the mouse a quick menu is shown. It's very handy especially when 
calibrating an image and adding labels. 
 
In LTVT the crater floors are considered to be level, which is not always correct, and it might be a bit 
confusing when shadow lengths in steep crater floors are measured. In LTVT the mountain heights are 
not taken into consideration. As a result, there is no information on the main window about it. The 
heights can be measured correctly on a calibrated photo by measuring the shadow length, or the user can 
check VMA's information. What's more, the coordinate indications near the limb are not 100% accurate. 
The Moon is considered as a Lambertian sphere, so the real terminator might not match neither the red 
nor the blue lines. These lines represent the borders of those areas where the sun is fully visible (red) and 
fully invisible (blue). The white circle indicates the libration zone. The accuracy of the coordinate values 
depends on the ephemeris (LTVT uses the JPL one) used as a database as well as on the coordinate 
system used. However, any deviation is minimal. 
 
In general, LTVT is a freeware that every beginner or advanced astronomer can easily use. It offers one 
more way for amateurs to provide important and numerous data. Furthermore it is a means for 
astronomers, amateurs and professionals, to collaborate and share experience. 
 

 
Distances on the lunar surface as calculated using LTVT and negative webcam 
image by the author.  (80ED APO f/7.5 Refractor - 28 July 2007 - 22:53:40 UT) 
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ON  THE  LIGHTER  SIDE  OF  THE  MOON 
Howard Eskildsen - Ocala, Florida, USA 

 
 
This is one of the strangest views of a crater (Birt) that I have seen.  Has Batman (Birtman?) actually 
landed on the moon?  I will have to notify the National Enquirer! 
  
The unusual dark markings in the center of the crater must be due to a combination of a ridge on the 
eastern part of Birt rising above the shadowed floor and the dark bands from the western crater 
converging with the shadows.  The constant changing of interior markings is another good reason to  
re-observe the craters over and over again.  
 
 

 
 

BIRT 
Digital image by Howard Eskildsen - Ocala, Florida, USA 

October 23, 2007 - 00:15 UT - Seeing: 7/10 - Trans: 4/5 
Meade 6 inch Refractor - 2x Barlow - Orion StarShoot II 
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OBSERVATIONS  RECEIVED 
 

 
WAYNE BAILEY - SEWELL, NEW JERSEY, USA 
Digital images of Alphonsus (2), Theophilus (2), Atlas & Hercules (3), Catharina, Alphonsus (4), 
Deslandres, Cassini (2), Dionysius, Pitatus, Schickard, Ptolemaeus (2),  

 
Banded Crater Report Forms with digital images of Beaumont-D, Eudoxus-A (2), Menelaus (2), 
Birt (2), Conon (2), Burg (3), Agatharchides-A, Mersenius-S, Hipparchus-K (2), Aristillus, 
Pytheas, Aristarchus, Bode, Hercules-G 

 
MAURICE COLLINS - PALMERSTON NORTH, NEW ZEALAND 
Digital images of Aristillus & Autolycus (2), Ptolemaeus region, Southern Terminator (2), Cassini,  
Montes Apeninnus, Deslandres, 1-day Moon, Bullialdus, Clavius, Sinus Iridum 

 
FRED CORNO - SETTIMO TORINESE, ITALY 
Drawings of Aristarchus (2) 

 
ED CRANDALL - WINSTON-SALEM, NORTH CAROLINA, USA 
Digital images of Theophilus area, Gassendi region, Copernicus, Montes Riphaeus, Kies Ray, Plato 

 
HOWARD ESKILDSEN - OCALA, FLORIDA, USA 
Digital images of Capuanus, Schiller-Zucchinus Basin, Dionysius, Birt, Alphonsus 

 
Banded Crater Report Forms with digital images of Ariadaeus, Bode, Silberschlag, Aristillus, 
Birt, Burg, Conon, Theaetetus, Pytheas 

 
DONALD SPAIN - LOUSVILLE, KENTUCKY, USA 
Computerized drawing of Alphonsus 

 
ROBERT WLODARCZYK - CZESTOCHOWA, POLAND 
Drawings of Gambart, Vitello & Lee & Doppelmayer 
 
 
 
 

LUNAR  TOPOGRAPHICAL  STUDIES 
Coordinator - William M. Dembowski, FRAS 

dembowski@zone-vx.com 
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RECENT  TOPOGRAPHICAL  OBSERVATIONS 
 
 

 
CATHARINA 

Digital image by Wayne Bailey - Sewell, New Jersey, USA 
October 31, 2007 - 05:44 UT - Seeing: 4/10 - Trans: 5/6 - Colong: 151.8 

Celestron 11 inch SCT - 2x Barlow - Lumenera Skynyx 2-1M Camera 
 
 

 
SINUS  IRIDUM 

Digital image by Maurice Collins - Palmerston North, New Zealand 
November 11, 2007 - Meade ETX90 - Meade LPI Camera 
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RECENT  TOPOGRAPHICAL  OBSERVATIONS 
 

 
MARE  HUMORUM  &  GASSENDI 

Digital image by Ed Crandall - Winston-Salem, North Carolina, USA 
November 21, 2007 - 00:46 UT - Colong: 45 - Seeing: 5-6/10 - Trans: 4/6 

110mm APO Refractor - 3x Barlow - Philips Toucam 
 
 

 
SCHILLER  ZUCCHIUS  BASIN 

Digital image by Howard Eskildsen - Ocala, Florida, USA 
October 23, 2007 - 00:01 UT - Seeing: 7/10 - Trans: 4/6 

Meade 6”  f/8  Refractor - 2x Barlow - Orion StarShoot II Camera 
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RECENT  TOPOGRAPHICAL  OBSERVATIONS 
 

 
VITELLO,  LEE,  &  DOPPELMAYER 

Drawing by Robert Wlodarczyk - Czestochowa, Poland 
September 23, 2007 - Approx. 18:30 UT - Seeing: 6/10 - Trans: 4/6 

18cm  f/6.6  Newtonian - 130x 
 

 
 

 

                When submitting observations to the A.L.P.O. Lunar Section 
 
In addition to information specifically related to the observing program being 
addressed, the following data should always be included: 
 
 Name and location of observer    
 Name of feature 
 Date and time (UT) of observation   
 Size and type of telescope used 

Orientation of image: (North/South - East/West) 
 Seeing: 1 to 10  (1-Worst  10-Best) 
 Transparency: 1 to 6  

Magnification (for sketches)                     
 Medium employed (for photos and electronic images) 
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PROGRESSION  OF  A  LUNAR  RAY  BISECTING  CRATER  KIES 
 

 
 

(Lunation: 10-days) 
Digital image by Bill Dembowski 

Elton, Pennsylvania, USA 
October 20, 2007 - 23:13 UT 

Celestron 8 inch SCT 
Orion StarShoot II 

 
 
 
 
 
 

(Lunation: 11-days) 
Digital image by Ed Crandall 

Winston-Salem, North Carolina 
November 20, 2007 - 01:10 UT 

110mm  APO  Refractor 
3x Barlow - Philips Toucam 

 
 
 
 
 
 
 

(Lunation: 13-days) 
Digital image by Howard Eskildsen 

Ocala, Florida, USA 
October 23, 2007 - 00:18 UT 

Meade 6”  f/8  Refractor 
2x Barlow - Orion StarShoot II 

 
 
 

BRIGHT  LUNAR  RAYS  PROJECT 
Coordinator - Willliam M. Dembowski, FRAS 
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Wayne Bailey is in the process of creating locator maps for the Banded Craters 
Program. The first three have been uploaded to the BCP Website at full resolution: 

 
Cassini-Conon Area - http://www.zone-vx.com/alpo-bcp-map1 

Copernicus Area - http://www.zone-vx.com/alpo-bcp-map2 
Hipparchus-Birt-Nicollet Area - http://www.zone-vx.com/alpo-bcp-map3 

 
 

 

BANDED  CRATERS  PROGRAM 
Coordinator - Willliam M. Dembowski, FRAS 

Banded Craters Program Website:  http://www.zone-vx.com/alpo-bcp.html

http://www.zone-vx.com/alpo-bcp-map1
http://www.zone-vx.com/alpo-bcp-map2
http://www.zone-vx.com/alpo-bcp-map3
http://www.zone-vx.com/alpo-bcp.html
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EDITOR:  
Due to some transient technical difficulties, the November LTP Newsletter did not 
appear in last month’s issue of TLO. It is presented here in its entirety. 

 
LTP  NEWSLETTER  -  NOVEMBER  2007 

Dr. Anthony Cook - Coordinator 
 

Observations were received from several observers during September – I hope to go back to 
more detailed descriptions of who submitted observations after I have sorted out my backlog of email 
files from the move from Nottingham to Aberystwyth. So apologies to those who have not seen their 
name appear in the last couple of months. 

 
This month I thought I would discuss Prof Arlin Crott’s paper No. 3, entitled: “Lunar 

Outgassing, Transient Phenomena and the Return to the Moon III: Observational and Experimental 
Techniques” Again I would just like to stress that as far as I am aware these series of papers have not 
been past the referee stage in the Icarus and Astrophysics journals and made it into print yet. However 
they are available for all to read on the following web site: http://www.astro.columbia.edu/~arlin/LTP/ 
at Columbia University in the US. So my summary is based upon these pre-published versions. Paper 3 
is concerned with how, using modern equipment it is possible to overcome many of the shortcomings of 
past opportunistic observations and detections. It is particularly important that a systematic approach for 
LTP detection is adopted to support current space missions such as SELENE and LRO. It is crucial that 
it can cope with the wide expected range of phenomena that might be seen (see discussion on paper II). 
The main proposed technique is called “subtraction”, namely taking an average image of a set of images 
of the same area of the Moon for reference, then taking a new image and simply looking for a 
difference. Edges features such as rough terrain may have to be masked out to remove seeing effects. A 
telescope on Cerro Tololo is now operating at an image scale of approximately 1 sec of arc per pixel and 
is imaging the Moon every 10 sec i.e. sufficiently long enough to pick up many types of LTP. The 
sensitivity will be at the 1% level and so 5-10 times more sensitive than the human eye – it is hoped that 
this increase in sensitivity will increase the detection frequency of LTP to perhaps several per month? 
The systematic nature of the detection system would avoid the possible statistical selection effects that 
have been suspected of being a problem in the past. Once the automated detection system has been 
perfected then there is the potential to bring scopes of higher angular resolution, polarization capability, 
or spectrographs on-line if the resources and funding are available?  

 
Discussion also takes place of detection of LTPs from orbit. Imaging cameras placed in the 

Lagrange points could augment Earth-based coverage with continuous coverage, but would be 
expensive if stand alone and not part of some other proposed space mission. To look for lunar ice 
reserves at say 15m (see paper 2) below the surface a high frequency radio sounder would be needed e.g. 
100-300MHz. Although working at much lower frequencies, the Lunar Reconnaissance Orbiter Mini 
Radio Frequency experiment might be able to map changes to the lunar regolith, from outgassing, by 
taking before and after imagery – this of course assumes that there will be sufficient imagery to overlap. 

LUNAR  TRANSIENT  PHENOMENA 
Coordinator – Dr. Anthony Cook – atc@aber.ac.uk 

Assistant Coordinator – David O. Darling - DOD121252@aol.com

http://www.astro.columbia.edu/~arlin/LTP/
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From low lunar orbit, the existing fleet of spacecraft due to go to the Moon will have smaller areas of 
the surface to map, but by imaging in blue wavelengths will be able to easily pick up fresh changes to 
the lunar soil, potentially from recent impacts, landslides, or outgassing, especially if previous short 
waveband imagery exist of the same areas which and can be used for comparison. Concerning Radon 
outgassing, the author states that the Alpha particle detector on the current SELENE mission will be 25 
times more sensitive than the Apollo 15 mission – so should be very suitable for mapping Radon release 
areas. For other gases a directional mass spectrometer would be appropriate which could recover both 
the atomic mass and direction of the particles in near real time – such equipment would fare better in 
very low lunar orbits in order to maximize sensitivity and spatial resolution.    

 
Predictions, including the more numerous illumination only events can be found on the following 

web site: http://www.alpo-astronomy.org/lunar/ltp.html. For members who do not have access to the 
internet, please drop me a line and I will post predictions to you. If you would like to join the LTP 
telephone alert team, please let me know your phone No. and how late you wish to be contacted. If in 
the unlikely event you see a LTP, please give me a call on my cell phone: +44 (0)798 505 5681 and I 
will alert other observers. Note when telephoning from outside the UK you must not use the (0). When 
phoning from within the UK please do not use the +44! 

 
Dr Anthony Cook, Institute of Mathematical and Physical Sciences, University of Aberystwyth, 
Penglais, Aberystwyth, Ceredigion, SY23 3BZ, WALES, UNITED KINGDOM. Email: atc@aber.ac.uk 
 

 
 

LTP  NEWSLETTER  -  DECEMBER  2007 
Dr. Anthony Cook - Coordinator 

 
Firstly Happy Holidays to all of our observers. Observations were received from the following 

observers during October: Clive Brook (Plymouth, UK), Tony Buick (UK), Maurice Collins 
(Palmerston, New Zealand), Marie Cook (Mundesley, UK), Raffaello Lena (Rome, Italy), Bill 
Dembowski (USA), Frank Melillo (Holtsville, NY, USA), Gerald North (Narborough, UK), and Adrian 
Pink (Basingstoke, UK). We had some LTP reports in October and these are detailed below: 
 
 On 2007 Oct 21 Gerald North, under Antoniadi IV-V seeing conditions, and with transparency 
fair-poor, noticed around 18:43 UT that the whole of Censorinus and it’s ejecta blanket were unusually 
bright for this stage in the lunar phase (in his opinion). A phone call was made to alert other observers. 
By 18:51 UT the Censorinus anomaly did not seem quite as bright and steadily faded to normal 
brightness in just under a minute. Nearby reference craters that included, Torricelli B and Moltke, 
remained constant in brightness throughout, apart from fraction of a second changes due to seeing 
conditions. 18:57-18:59 UT Censorinus looked normal in brightness for this phase, but suspected some 
short slight peaks in brightness spanning periods of ~10 seconds. 19:00-19:08 UT Censorinus was 
normal in brightness apart from obvious small seeing fluctuations. 19:11-19:27 UT the same but now 
some thin cloud increasing over the Moon. 19:46 UT Moon was now only seen through a thick hazy 
cloud and observations ceased. Gerald comments that what he saw was a genuine change in “apparent” 
brightness in Censorinus and it’s ejecta blanket, however this does not necessarily mean that it was a 
real LTP. Instead Gerald considers the possibility that with Censorinus being a nearly point like feature 
that, the effect of the atmospheric seeing disk on this crater is more pronounced than with other craters. 
Whilst it is certainly true that seeing affects the appearance of point-like features more than bigger 
features, I would have thought that poor seeing should have redistributed the brightness over a larger 
area, causing a fade in the brightest surface brightness, rather than an overall brightening. Unless of 
course the time when Censorinus was seen as very bright was a stable period of good? However the 

http://www.alpo-astronomy.org/lunar/ltp.html
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reported seeing conditions suggest otherwise. Anyway in Gerald’s personal opinion he rates his 
observation as low in terms of probability of being a LTP because it was made under poor seeing and 
under far from ideal transparency. 
 
 As we had not had a LTP alert for a while, and also because of the necessity to react quickly 
(LTP are often short term in nature) I telephoned a selection of observers and asked David Darling to 
email the rest. The following observers responded – note that some of these are several hours before, 
and the rest are after the LTP. Bill Dembowski and Frank Melillo had obtained earlier high resolution 
images from 00:05-02:39 UT (see Fig 1). Although Censorinus in the 02:39UT image looks fainter, this 
is a contrast effect as you can see that the contrast of the other features has changed too. 
 
 

 
     Fig 1 Bill Dembowski UT 00:05        Frank Melillo 02:30UT             Frank Melillo 02:39UT 
 

 
Post LTP observations were received from three observers. Marie Cook observed from 19:00-

19:58 UT and although she noted Censorinus to be very bright, she considered this to be normal. She 
estimated it to be twice as bright as Proclus. Tony Buick and Raffaello Lena (GLR) obtained a mosaic 
image (19:27-1931 UT), but again these showed nothing unusual and were after the event – however 
they both showed that Proclus was about 10% brighter than Censorinus in contrast to Marie Cook’s 
visual observation. I put this down to the darkness of the background Moon that we see these two bright 
craters against which is less easy to compensate for with visual observations than with direct pixel 
brightness readouts with CCD images. 

 
The other two LTP reports were on 2007 Oct 23 at 21:15 UT when Clive Brook, using a 4” 

refractor at x130, noted a “fleeting faint reddish patch” inside Gassendi. Was anybody else observing 
then? I recently heard that Clive has had to stop observing due to ill health – so we wish him a speedy 
recovery. Also I heard, via Peter Grego of a Society for Popular Astronomy observer, that Adrian Pink 
detected a star like point in the night side of the south east corner of the Moon. However later inspection 
of the image shows that this was probably a cosmic ray strike on the CCD camera. 

 
Predictions, including the more numerous illumination only events can be found on the following 

web site: http://www.lpl.arizona.edu/~rhill/alpo/lunarstuff/ltp.html. For members who do not have 
access to the internet, please drop me a line and I will post predictions to you. If you would like to join 
the LTP telephone alert team, please let me know your phone No. and how late you wish to be 
contacted. If in the unlikely event you see a LTP, please give me a call on my cell phone: +44 (0)798 
505 5681 and I will alert other observers. Note when telephoning from outside the UK you must not use 
the (0). When phoning from within the UK please do not use the +44! 

 
Dr Anthony Cook, Institute of Mathematical and Physical Sciences, University of Wales Aberystwyth, 
Penglais, Aberystwyth, Ceredigion, SY23 3BZ, WALES, UNITED KINGDOM. Email: atc@aber.ac.uk 

 

http://www.lpl.arizona.edu/~rhill/alpo/lunarstuff/ltp.html
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  1. Agatharchides-A 
  2. Ariadaeus 
  3. Aristarchus 
  4. Birt 
  5. Gambart 
  6. Catharina 
  7. Censorinus 

 
 
 
 
 
 
 

 
 

  
 
 
 
  8. Gassendi 
  9. Iridum, Sinus 
10. Kies 
11. Menelaus 
12. Schiller 
13. Vitello 
 
               X  = Alphonsus 
      (Subject of next Focus On) 
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